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Περιήγηση στο περιβάλλον Blender 

 Το Blender έχει ένα πολύ ασυνήθιστο περιβάλλον εργασίας, βελτιστοποιημένο στο έπακρο 
για παραγωγή 3D γραφικών. Μπορεί να προκαλέσει σύγχυση σε έναν νέο χρήστη άλλα 

αποδεικνύει την δύναμή του μακροπρόθεσμα. Επομένως, είναι απαραίτητη η εξοικείωση με το περιβάλλον 
περιήγησης, τα εικονίδια εργαλείων που περιέχει και τα κουμπιά χειρισμού των αντικειμένων εντός της σκηνής. 

Το λογισμικό αυτό παρέχει ένα ευρύ φάσμα λειτουργιών, όπως μοντελοποίηση, δημιουργία/εφαρμογή υφών, 
φωτισμού, κινήσεων, επεξεργασίας βίντεο και δημιουργία παιχνιδιών/animation σε ένα ολοκληρωμένο πακέτο. 
Μέσω της ανοικτής του αρχιτεκτονικής το Blender παρέχει διαπλατφορμική διαλειτουργικότητα, επεκτασιμότητα, 
ένα εξαιρετικά μικρό μέγεθος αρχείου και μια σφικτά ενσωματωμένη ροή εργασίας. Το Blender είναι μία από τις 
δημοφιλέστερες εφαρμογές 3D γραφικών ανοικτού κώδικα στον κόσμο. Στοχεύοντας παγκοσμίως στους 
επαγγελματίες των μέσων και στους καλλιτέχνες, το Blender μπορεί να χρησιμοποιηθεί για την δημιουργία 3D 
οπτικοποιήσεων, εικόνων, καθώς επίσης και για βίντεο κινηματογραφικής ποιότητας, ενώ η ενσωμάτωση μιας 3D 
μηχανής πραγματικού χρόνου επιτρέπει την δημιουργία 3D διαδραστικού περιεχομένου για αυτόνομη 
αναπαραγωγή.  

Το Blender δημιουργείται κι εξελίσσεται ως 'Ελεύθερο Λογισμικό', με τον πηγαίο κώδικά 
του διαθέσιμο κάτω από την άδεια GNU GPL (ΓGeneral Public License). Όταν κάποιος 
ακούει για "ελεύθερο λογισμικό", το πρώτο πράγμα που έρχεται στο μυαλό του μπορεί να 
είναι "χωρίς κόστος". Στις περισσότερες περιπτώσεις αυτό είναι αλήθεια! Ο όρος 
"ελεύθερο λογισμικό", όπως χρησιμοποιείται από το Ίδρυμα Ελεύθερου Λογισμικού έχει 
ως στόχο να σημαίνει "δωρεάν ως προς την ελευθερία" και όχι την "χωρίς κόστος χρήση".  
Δωρεάν λογισμικό με αυτή την έννοια είναι το λογισμικό που είναι ελεύθερο να 
χρησιμοποιηθεί, αντιγραφεί, τροποποιηθεί, αναδιανεμηθεί χωρίς περιορισμό. Συγκρίνετε 
αυτό με την αδειοδότηση των πιο εμπορικών πακέτων λογισμικού (π.χ. Autodesk 3D Studio 
Max), όπου έχετε τη δυνατότητα να εγκαταστήσετε το λογισμικό σε έναν υπολογιστή, δεν 
επιτρέπεται όμως να κάνετε κανένα αντίγραφο και να έχετε πρόσβαση στον πηγαίο κώδικα 

του προγράμματος. Το ελεύθερο λογισμικό επιτρέπει την απίστευτη ελευθερία στον τελικό χρήστη. Δεδομένου ότι 
ο πηγαίος κώδικας είναι καθολικά διαθέσιμος, υπάρχουν επίσης πολλές περισσότερες πιθανότητες τα κρυμμένα 
λάθη (bugs) να βρεθούν και να διορθωθούν. 

Όταν ένα πρόγραμμα είναι υπό την άδεια GNU GPL: 

 έχετε το δικαίωμα να χρησιμοποιήσετε το πρόγραμμα για οποιονδήποτε σκοπό 

 έχετε το δικαίωμα να τροποποιήσετε το πρόγραμμα και να έχετε πρόσβαση στον πηγαίο κώδικα  

 έχετε το δικαίωμα να αντιγράψετε και να διανείμετε το πρόγραμμα 

 έχετε το δικαίωμα να βελτιώσετε το πρόγραμμα και να δημοσιοποιήσετε  τις εκδόσεις σας. 

Σε αντάλλαγμα για τα δικαιώματα αυτά, έχετε κάποιες ευθύνες αν διανείμετε ένα GPL πρόγραμμα, τις ευθύνες που 
έχουν σχεδιαστεί για να προστατεύουν τις ελευθερίες σας και τις ελευθερίες των άλλων:  

 Πρέπει να δώσετε ένα αντίγραφο της GPL με το πρόγραμμα, ώστε ο παραλήπτης να γνωρίζει τα δικαιώματά 
του στο πλαίσιο της άδειας. Το αντίγραφο αυτό θα πρέπει να περιλαμβάνει τον πηγαίο κώδικα ή να κάνει 
τον πηγαίο κώδικα ελεύθερα διαθέσιμο. 

 Εάν τροποποιήσετε τον κώδικα και διανείμετε την τροποποιημένη έκδοση, πρέπει να αποκτήσετε άδεια 
τροποποίησης σύμφωνα με την GPL και να κάνετε τον πηγαίο κώδικα των αλλαγών σας διαθέσιμο.  
 

Τα βασικά χαρακτηριστικά του συγκεκριμένου λογισμικού συνοψίζονται στα 
ακόλουθα:  

 

 Πλήρως ενσωματωμένη σουίτα δημιουργίας, η οποία προσφέρει μία ευρεία γκάμα βασικών εργαλείων για 

τη δημιουργία 3D περιεχομένου, συμπεριλαμβανομένων μοντελοποίησης, δημιουργίας υφής, 

προσομοίωσης, μετα-επεξεργασίας γραφικών, αναπαραγωγής σκηνών  
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 Συμβατή πλατφόρμα με OpenGL ενιαίο γραφικό περιβάλλον χρήστη (GUI) σε κάθε πλατφόρμα 

(προσαρμοσμένη και με scripts σε γλώσσα Python), διαθεσιμότητα και χρηστικότητα σε διάφορα 

λειτουργικά συστήματα (Windows, Linux, OS X, FreeBSD, Irix, Sun) 

 Τρισδιάστατη αρχιτεκτονική υψηλής ποιότητας, η οποία προσφέρει γρήγορη και αποδοτική δημιουργία 

ροής εργασίας (work-flow) 

 Πληθώρα επιλογών downloads κάθε έκδοσης από χρήστες παγκοσμίως;  

 Υποστήριξη κοινωνίας χρηστών μέσω forums για ερωτήσεις, απαντήσεις, κριτικές, υπηρεσίες 

(http://BlenderArtists.org και  http://BlenderNation.com)  

 Μικρό εκτελέσιμο αρχείο, για εύκολη αναδιανομή 

 

Εισαγωγή στην πλοήγηση 

Χρησιμοποιώντας το Blender μπορείτε να δημιουργήσετε έναν κόσμο 
τεσσάρων διαστάσεων:  

1. Αριστερά – δεξιά, συνήθως αποκαλείται ο άξονας «χ».  

2. Μπρος – πίσω, συνήθως αποκαλείται ο άξονας «y».  

3. Πάνω-κάτω, συνήθως αποκαλείται ο άξονας «z».  

4. Αίσθηση του χρόνου, διαμέσου κινούμενων αντικειμένων, υλικών,  

               και κίνησης σε κάδρα.  

Το πρόβλημα είναι ότι έχετε μια δισδιάστατη οθόνη υπολογιστή μπροστά σας! Ο κέρσορας του ποντικιού μπορεί να 
κινηθεί μόνο αριστερά-δεξιά και πάνω-κάτω. Δεν μπορείτε να πάτε πίσω τον χρόνο και τυπικά δεν μπορείτε να 
φτάσετε το άκρο της οθόνης και να «πιάσετε» ένα αντικείμενο το οποίο έχει τοποθετηθεί κάπου αλλού. Αντίθετα, 
πρέπει να πείτε στο Blender να το εφαρμόσει για σας.  

Στις παρακάτω παραγράφους γίνεται μια συνοπτική αναφορά στον τρόπο με τον οποίο μπορείτε να πλοηγηθείτε 
στον εικονικό κόσμο χρησιμοποιώντας το μοναδικό περιβάλλον χρήστη του Blender. Το λογισμικό αυτό έχει την 
ιδιαιτερότητα πως χρησιμοποιώντας συντομεύσεις πλήκτρων (HOTKEYS) μπορούμε να ολοκληρώσουμε ταχύτατα 
τις επιθυμητές ενέργειες, δουλεύοντας πλέον ως επαγγελματίες!  

 

 Αρπαγή/Μετακίνηση αντικειμένου 

Mode: Object and Edit modes  

Hotkey: G  

Menu: Object/Mesh/etc. → Transform → Grab/Move  

Ένας από τους γρηγορότερους τρόπους για να μετακινήσετε ένα αντικείμενο στον τρισδιάστατο χώρο είναι 
πιέζοντας το πλήκτρο G. Έτσι μεταβαίνετε στην κατάσταση Αρπαγής/Μετακίνησης του επιλεγμένου αντικειμένου 
σύμφωνα με τη θέση του ποντικιού. Η απόσταση από τον δείκτη έως το χειριζόμενο αντικείμενο δεν παίζει κανένα 
ρόλο.  
 

Επιλογές 

Aριστερό κλικ ποντικιού  : Επιβεβαίωση κίνησης του αντικειμένου, και τοποθέτησή του στην τρέχουσα θέση της 
οθόνης.  

Ροδέλα: Περιορισμός της κίνησης στους άξονες Χ, Υ, Ζ.  

Δεξί κλικ ποντικιού  ή Escape: Ακύρωση της μετακίνησης και επιστροφή του αντικειμένου στην αρχική του θέση.  

 
 

http://blenderartists.org/
http://blendernation.com/
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Πλήκτρο R : Πιέζοντας το πλήκτρο R ενεργοποιείτε την κατάσταση περιστροφής μεταξύ ενός άξονα και ενός 
δεύτερου. Η περιστροφή των αντικειμένων ελέγχεται από τους άξονες Χ,Υ ταυτόχρονα σύμφωνα με τη θέση του 
ποντικιού. Αυτός μπορεί να είναι ένας γρήγορος τρόπος για την περιστροφή ενός αντικειμένου χωρίς να χρειάζεται 
να αλλάζετε συνεχώς την άποψη περιστροφής.  

 

 Κλίμακα - αλλαγή μεγέθους αντικειμένου 

Mode: Object and Edit modes  

Hotkey: S  

Menu: Object/Mesh/etc. → Transform → Scale  

Πιέζοντας το πλήκτρο S θα εισαχθείτε στην κατάσταση Κλίμακας ενός αντικειμένου, στην οποία μπορείτε να 
αλλάξετε την κλίμακα προς τα μέσα ή προς τα έξω σύμφωνα με τον δείκτη του ποντικιού. Η κλίμακα θα αυξηθεί αν 
ο δείκτης μετακινηθεί μακριά από το σημείο περιστροφής και μειώνεται αν στραφεί προς αυτό. Αν ο δείκτης 
περάσει από την απέναντι μεριά τότε το αντικείμενο θα συνεχίσει να αυξομειώνεται αλλά θα αλλάξει επιφάνεια. Η 
ακρίβεια της κλίμακας εξαρτάται από την απόσταση του δείκτη του ποντικιού μεταξύ αυτού και του αντικειμένου 
που έχει επιλεχθεί.  

Επιλογές 

Aριστερό κλικ ποντικιού  : Επιβεβαίωση της αλλαγής κλίμακας του αντικειμένου. Αφήστε πλήκτρο και θα πάρει 
την τρέχουσα θέση.  

Ροδέλα: Περιορισμός στους άξονες Χ,Υ,Ζ.  

Δεξί κλικ ποντικιού  ή Escape : Ακύρωση της αλλαγής κλίμακας και επιστροφή του αντικειμένου στην 
προηγούμενη θέση.  

 

 Κατοπτρισμός 

Mode: Object and Edit modes  

Hotkey: Ctrl +M  

Menu: Object/Mesh/etc. → Mirror  

Αντικατοπτρίζοντας αντικείμενα σημαίνει να τα αντιστρέφουμε σε έναν άξονα, σύμφωνα με το σημείο περιστροφής 
τους με κλίμακα. Χρησιμοποιήστε τα πλήκτρα συντόμευσης Ctrl+M και έπειτα πατήστε Χ,Υ, Ζ για να το 
αντικατοπτρίσετε στον αντίστοιχο άξονα. Μπορείτε να πατήσετε και το αριστερό κλικ του ποντικιού και να 
μετακινήσετε το αντικείμενο στον άξονα που θέλετε να γίνει ο αντικατοπτρισμός.  
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Υπάρχουν πολλά πράγματα που μπορείτε να κάνετε με τα επιλεγμένα αντικείμενα στον εικονικό κόσμο. Μπορείτε 
να τα μετακινήσετε, να τα μεγεθύνετε ή να τα συρρικνώσετε, να τους αλλάξετε το σχήμα κτλ. Οι ακόλουθες 
παράγραφοι σας δείχνουν πώς ακριβώς θα το κάνετε στα αντικείμενά σας.  

Μετασχηματισμοί Αντικειμένων 

 Μετάφραση- Μετατόπιση (Translation)  

 Περιστροφή (Rotation)  

 Κλίμακα (Scaling)  

 Κατοπτρισμός (Mirroring)  

Εργαλεία Μετασχηματισμού 

 Αλλαγή κέντρου περιστροφής  

 Κλείδωμα άξονα  

 Προτατική επεξεργασία  

 Αλλαγή μεταμόρφωσης κατεύθυνσης  

Μέθοδοι Μετασχηματισμού 

 Πλήκτρα συντόμευσης  

 Χειρισμοί  

 Κουμπιά μενού  

 Μενού περιεχομένου  

 Πάνελ ρυθμίσεων μεταποίησης  

 Χειρονομίες  

 

Με επιλεγμένο ένα αντικείμενο σε 3d άποψη, στο Object 
Mode, η μπάρα του μενού εμφανίζει τις αντίστοιχες 
επιλογές. Υπάρχει η επιλογή Transform. Κουνώντας τον 
δείκτη του ποντικιού πάνω από αυτή την επιλογή 
εμφανίζεται ένα υπομενού με επιλογές για τον χειρισμό 
του εν λόγω αντικειμένου όπως:  

 Μετακίνηση  

 Περιστροφή  

 Κλίμακα  

 Γεωμετρία  

 Τυχαία μεταμόρφωση  

 Ευθυγράμμιση αντικειμένων  

 

Καθρέφτης (Mirror) 

Περιλαμβάνει εργαλεία για κατοπτρισμό των αντικειμένων προς διαφορετικές κατευθύνσεις  

Καθαρισμός (Clear) 

Επαναφέρει τις μεταμορφώσεις ενός αντικειμένου  

Εφαρμογή (Apply) 

Θέτει τις μεταμορφώσεις ενός αντικείμενου στην αρχική, αλλά κρατάει όλα τα συστατικά στην ίδια θέση.  



Περιήγηση στο περιβάλλον BLENDER – Λιβανός Γ. – Παπαδημητρίου Δ. Σελίδα 5 
 

Επιλογή 

Η επιλογή των αντικειμένων τα τοποθετεί στο πλέγμα ή τον 3d κέρσορα.  

Χειριστές 

Mode: Object and Edit modes  

Hotkey: Ctrl+Space  

 

Συνδυασμός Χειριστών. 

Όταν χρησιμοποιείτε τις εντολές μετασχηματισμού (G για άρπαγμα, R για περιστροφή, S για κλίμακα), λειτουργούν 
παράλληλα για την τρέχουσα άποψη.  

Τις περισσότερες φορές θα πρέπει να εφαρμόσετε κλείδωμα των αξόνων:  

 Αμέσως μετά το G, R ή S μπορείτε να πατήσετε τα X,Y ή Z για να περιορίσετε τον μετασχηματισμό σε έναν 
γενικό άξονα.  

 Χρησιμοποιώντας τη ροδέλα του ποντικιού θα γίνει το ίδιο αλλά κατά μήκος του κοντινότερου άξονα από 
τον δείκτη του ποντικιού.  

Μπορείτε να κάνετε το ίδιο χρησιμοποιώντας τους χειριστές: Παρέχουν μια οπτική αναπαράσταση του 
μετασχηματισμού και επιτρέπουν την κίνηση, περιστροφή και κλίμακα κατά μήκος οποιουδήποτε άξονα σε κάθε 
κατάσταση και προς οποιαδήποτε πλευρά του 3D παραθύρου. Υπάρχει ξεχωριστός χειριστής για κάθε Επιλογή 
Μετασχηματισμού. Κάθε μία μπορεί να θεαθεί ξεχωριστά ή σε συνδυασμό με άλλες.  

 

Κεφαλίδα Χειριστών. 

Οι Χειριστές φαίνονται στη κεφαλίδα του 3D παραθύρου ή στην εργαλειοθήκη "Object tools", ανάλογα με την 
έκδοση του προγράμματος:  

 Χέρι: Ενεργοποιεί/απενεργοποιεί τους χειριστές.  

 Τρίγωνο: Μετάφραση/Θέση.  

 Κύκλος: Περιστροφή  

 Κουτί: Κλίμακα  

 Μενού προσανατολισμού μετασχηματισμού: Επιλογή του προσανατολισμού ενός μετασχηματισμού.  
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Translate 

 

 

Rotate 

 

 

Scale 

 

 

Combination 

 
Κάνοντας κλικ πάνω στους Χειριστές πατώντας ταυτόχρονα Shift+αριστερό κλικ πάνω στα εικονίδια, μπορούν να 
επιλεγούν περισσότεροι από ένας χειριστές.  

Εφόσον έχουν επιλεγεί οι χειριστές μπορείτε να τους επιλέξετε με Ctrl+Alt+G για Αρπαγή/Μετακίνηση, Ctrl+Alt+R 
για περιστροφή και Ctrl+Alt+S για αλλαγή κλίμακας.  

Ρυθμίσεις Χειριστών 

    ή   

Manipulator preferences. 

Οι ρυθμίσεις των χειριστών μπορούν να βρεθούν στον τομέα View & Controls ή Interface του παραθύρου User 
Preferences .  

 Size: Διάμετρος σε pixels.  

 Handle: Μέγεθος, σε ποσοστό της ακτίνας.  

 Hot spot Μέγεθος Σημείου σε pixels.  

 

  

http://wiki.blender.org/index.php/File:Manual-Manipulators-Rotate.jpg
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Επεξεργασία Προσανατολισμού 

Mode: Object and Edit modes  

Hotkey: Alt+Space  

 

Transform orientations selection menu. 

Ένας δευτερεύων προσανατολισμός μπορεί να επιλεγεί με Alt+Space ή μέσω του μενού Orientation στην κεφαλίδα 
της 3D άποψης.  

Επιλογές 

Παρακάτω δίνεται μια λίστα με τους διαφορετικούς τύπους τροποποίησης. Σε κάθε εικόνα, συγκρίνετε τη θέση των 
αξόνων χειρισμού (χρωματιστοί άξονες πάνω από τα αντικείμενα), οι οποίοι υλοποιούν τον προσανατολισμό της 
μεταμόρφωσης, με το ολικό (Global) και το τοπικό (Local) (το αντικείμενο να είναι άδειο, έτσι ώστε μόνο οι τοπικοί 
άξονες να φαίνονται).  

 

Global : O χειριστής ταιριάζει τον παγκόσμιο άξονα.  

 

Local: Ο χειριστής ταιριάζει τον άξονα του αντικειμένου.  
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Normal: Ο χειριστής του άξονα Ζ θα ταιριάξει το συνήθες διάνυσμα του επιλεγμένου αντικειμένου. Δεν είναι πολύ 
χρήσιμο για ένα άδειο. Δείτε το παράδειγμα παρακάτω.  

 

Παράδειγμα κύβου. 

Ένα καλύτερο παράδειγμα χρησιμοποιώντας τις όψεις, επιλέγοντάς τες από το Edit mode.  

 

View: Ο χειριστής θα ταιριάξει την 3D άποψη, Y → Πάνω/Κάτω, X → Αριστερά/Δεξιά, Z → Προς/Μακριά από σας.  
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Πάνελ Προσανατολισμών 

Το Transform Orientations πάνελ, που βρίσκεται στο View Properties Panel, μπορεί να χρησιμοποιηθεί για να 
διαχειριστεί προσανατολισμούς: Επιλέγοντας έναν ενεργό προσανατολισμό, προσθέτοντας και μετακινώντας 
συνήθεις προσανατολισμούς ή διαγράφοντάς τους.  

 

Transform Orientations πανελ. 

 

Επιλέγοντας έναν συνήθη προσανατολισμό. 

Ιδιότητες Μετασχηματισμού 

Κάθε αντικείμενο αποθηκεύει τη θέση του, τον προσανατολισμό του και την κλίμακά του. Όλα τα παραπάνω 
μπορεί να χρειαστεί να χειριστούν αριθμητικά, να επαναφερθούν ή να εφαρμοστούν.  

Πάνελ Ιδιοτήτων Μετασχηματισμού 

Mode: Edit and Object modes  

Hotkey: N  

Menu: Object » Transform Properties  

Ο τομέας Transform Properties στο πάνελ View Properties σας επιτρέπει 
να βλέπετε και να ελέγχετε χειροκίνητα/αριθμητικά τη θέση, την 
περιστροφή και άλλες ιδιότητες ενός αντικειμένου, στο Object Mode. 
Στο Edit mode, σας επιτρέπει να εισάγετε μια ακριβή τιμή 
συντεταγμένων για ένα διάνυσμα ή μια μέση θέση για μια ομάδα από 
διανύσματα.  

 

Επιλογές του Object Mode 

Transform Properties panel in Object mode. 

Θέση Χ, Θέση Υ, Θέση Ζ  

Η κεντρική θέση του αντικειμένου στις γενικές συντεταγμένες.  

 

Περιστροφή Χ, Περιστροφή Υ, Περιστροφή Ζ  

Ο προσανατολισμός του αντικειμένου σε σχέση με τους γενικούς άξονας 
και τη δική του θέση.  

 

Κλίμακα Χ, Κλίμακα Υ, Κλίμακα Ζ  

Η κλίμακα του αντικειμένου σε σχέση με το κέντρο του στις τοπικές συντεταγμένες. Κάθε αντικείμενο (κύβος, 
σφαίρα, κτλ) όταν δημιουργηθεί έχει μια κλίμακα μιας μονάδας του Blender προς κάθε τοπική κατεύθυνση. Για να 
κάνετε ένα αντικείμενο μεγαλύτερο ή μικρότερο, του αλλάζετε κλίμακα προς την επιθυμητή κατεύθυνση.  

 

Διαστάσεις Χ, Διαστάσεις Υ, Διαστάσεις Ζ  
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Οι βασικές διαστάσεις ενός αντικειμένου (σε μονάδες Blender) από μια εξωτερική γωνία προς μια άλλη, σαν να 
μετρήθηκε με χάρακα. Για πολλαπλές επιφάνειες αυτά τα πεδία σας δίνουν τις διαστάσεις ενός οριοθετούμενου 
κουτιού.  

Χρησιμοποιήστε αυτό το πάνελ είτε για να επεξεργαστείτε είτε για να εμφανίσετε τις ιδιότητες μετασχηματισμού 
ενός αντικειμένου, όπως θέση, περιστροφή, κλίμακα. Αυτά τα πεδία αλλάζουν το κέντρο του αντικειμένου και 
έπειτα επηρεάζουν την άποψη όλων των πλευρών του.  

Κλείδωμα ιδιοτήτων μετασχηματισμού 

Το κλείδωμα της Θέσης, Περιστροφής και Κλίμακας σας επιτρέπει να χειριστείτε τον μετασχηματισμό ενός 
αντικειμένου αποκλειστικά. Για παράδειγμα αν κλειδώσατε τη Θέση Χ τότε δεν μπορείτε να μετακινήσετε το 
αντικείμενο κατά τον Χ άξονα.  

Εφαρμόζοντας τον Μετασχηματισμό 

Εφαρμόζοντας τις τιμές μετασχηματισμού τυπικά επαναφέρει τις τιμές θέσης, περιστροφής και κλίμακας ενός 
αντικειμένου αλλά τυπικά δεν κάνει κάτι στο αντικείμενο. Το κεντρικό σημείο μετακινείται στην αρχή και οι τιμές 
μετασχηματισμού θέτονται στο μηδέν. Σε όρους κλίμακας η τιμή έρχεται στο 1.  

Για να εφαρμόσετε έναν μετασχηματισμό επιλέξτε το υπομενού Apply του μενού Object ή χρησιμοποιήστε τα 
πλήκτρα Ctrl+A και επιλέξτε τον κατάλληλο μετασχηματισμό για να τον εφαρμόσετε.  

Απαλείφοντας τον Μετασχηματισμό 

Καθαρίζοντας τους μετασχηματισμούς επιστρέφουν οι τιμές στις αρχικές ενδείξεις. Η θέση και η περιστροφή του 
αντικειμένου επιστρέφει στο 0 και η κλίμακα στο 1.  

 Clear Transform: Alt+G  

 Clear Rotation: Alt+R  

 Clear Scale: Alt+S  

 Clear Origin: Alt+O  

  



Περιήγηση στο περιβάλλον BLENDER – Λιβανός Γ. – Παπαδημητρίου Δ. Σελίδα 11 
 

Εργαλειοθήκη 3D 

Η τρισδιάστατη απεικόνιση (3D View) είναι η εργαλειοθήκη όπου εκτελείται το μεγαλύτερο μέρος της 
μοντελοποίησης ενός αντικειμένου και της δημιουργίας της σκηνής. Το Blender διαθέτει μια ευρεία γκάμα 
εργαλείων και επιλογών με σκοπό την υποστήριξη της εργασίας σας με το ποντίκι και το πληκτρολόγιο. Η επίπεδη 
(δύο διαστάσεων) οθόνη του Η/Υ σας είναι η οπτική σας στον τρισδιάστατο χώρο.  

Η γκάμα αυτή αποτελεί επίσης την παλαιότερη και αυτή με τα περισσότερα στοιχεία εργαλειοθήκη του Blender. Οι 
περισσότεροι χρήστες δεν χρησιμοποιούν όλα τα στοιχεία που διαθέτει, όπως ακριβώς δεν χρησιμοποιούμε όλες 
τις λέξεις του λεξικού στην καθημερινή μας επικοινωνία.  

Παράθυρο Εργαλειοθήκης 3D  

Η τρισδιάστατη άποψη αποτελείται από την επιφάνεια εργασίας και την κεφαλίδα. Η κεφαλίδα φαίνεται στο κάτω 
μέρος την οθόνης ακριβώς κάτω από την επιφάνεια εργασίας.      (H 3D View κεφαλίδα) 

 

Μενού View:  

Properties Panel  

Αναπτύσσει το μενού των επιλογών το οποίο επιτρέπει να 
ρυθμίσετε διάφορες 3D επιλογές::  

 Μετασχηματισμός (Transform)  

 Πινέλο (Grease Pencil)  

 Προβολή (View)  

 Αντικείμενο (Item)  

 Παρουσίαση (Display)  

 Εικόνες παρασκηνίου (Background Images)  

 Προσανατολισμός μετασχηματισμού (Transform 
Orientation)  

Tool Shelf  

Αναπτύσσει το μενού εργαλείων, το οποίο εμφανίζεται στα 
αριστερά της 3d άποψης, και σας επιτρέπει να διενεργείτε 
διάφορες λειτουργίες εξαρτώμενες του τύπου του 
αντικειμένου που έχετε επιλέξει, καθώς και την κατάσταση 
στην οποία είστε.  

Camera (0 NumPad):  Εναλλάσσει την γωνία θέασης της τρέχουσας οπτικής γωνίας.  

Viewing angles: Αυτές οι εντολές αλλάζουν την οπτική γωνία από την προεπιλεγμένη σε Πάνω/Κάτω, 
Μπροστά/Πίσω ή Αριστερά/Δεξιά.  

 Top (7 NumPad)  

 Bottom (Ctrl+7 NumPad)  

 Front (1 NumPad)  

 Back (Ctrl1 NumPad)  

 Right (3 NumPad)  

 Left (Ctrl3 NumPad)  
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Camera Menu: 

Set Active object as camera (Θέτει ως κάμερα το ενεργό αντικείμενο)  

Active camera (Η ενεργή κάμερα)  

 

Perspective/Orthographic View (5 NumPad) : Αυτές οι εντολές αλλάζουν την προβολή της 3D άποψης.  

 

Navigation Menu : Αυτό το υπό-μενού εμπεριέχει εντολές για την περιστροφή της γωνίας θέασης. Η χρήση αυτών 
των εντολών δεν είναι και τόσο αποτελεσματική. Ωστόσο, όπως σε όλα τα μενού του Blender, τα πιο χρηστικά 
κουμπιά του πληκτρολογίου αναγράφονται δίπλα από κάθε επιλογή.  

Align View : 

Αυτό το υπό-μενού σας επιτρέπει να ευθυγραμμίζετε τις 3d απόψεις με διάφορους τρόπους.  

 Align to selected (Ευθυγράμμιση του επιλεγμένου)  

 Center cursor and view all (Κεντράρισμα τον κέρσορα)  

 Align active camera to view (Ευθυγράμμιση κάμερας)  

 View Selected (Θέα των επιλεγμένων)  

 Center View to cursor (Κεντρική θέα)  

 

Clipping Border (Alt+B) : Σας επιτρέπει να ορίσετε ένα απόκομμα περιθωρίου για να περιορίσετε την τρισδιάστατη 
άποψη για μια μερίδα τρισδιάστατου χώρου.  

 

Zoom Border... (⇧ Shift+B) : Σας επιτρέπει να ορίσετε μια περιοχή την οποία θέλετε να μεγεθύνετε.  

 

Show all Layers (~) : Θέτει ορατές όλες τις επιφάνειες.  

 

Global View/Local View (/ NumPad) : Η ολική θέαση δείχνει όλα τα όλα τα 3d αντικείμενα της σκηνής. Η τοπική 
θέαση εμφανίζει μόνο τα επιλεγμένα αντικείμενα. Αυτό βοηθά αν υπάρχουν πάρα πολλά αντικείμενα στη σκηνή, 
που μπορεί να μπερδεύονται μεταξύ τους.  

 

View Selected (. NumPad) : Μεγεθύνει την 3D άποψη για να συμπεριλάβει τα επιλεγμένα αντικείμενα.  

 

View All (↖ Home) : Μεγενθύνει την 3D άποψη για να συμπεριλάβει όλα τα αντικείμενα.  

 

Play Back Animation (Alt+A): Αναπαράγει την κίνηση από το τρέχον καρέ.  

 

Duplicate area in new window : Αντιγράφει την τρέχουσα 3D άποψη σε ένα νέο παράθυρο.  

 

Quad View : Εμφανίζει ένα τετραπλό παράθυρο με 3d απόψεις, κάθε μια να δείχνει διαφορετική γωνία της σκηνής.  

 

Toggle Full Screen(Ctrl↑) : Μεγιστοποιεί το 3D View παράθυρο σε όλη την οθόνη.  

http://wiki.blender.org/index.php/Doc:2.6/Manual/3D_interaction/Navigating/3D_View
http://wiki.blender.org/index.php/Doc:2.6/Manual/3D_interaction/Navigating/3D_View#View_Clipping_Border
http://wiki.blender.org/index.php/Doc:2.6/Manual/Animation
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Μενού Επιλογών  

Αυτό το μενού εμπεριέχει εργαλεία για την επιλογή των αντικειμένων.  

Μενού Αντικειμένων  

Αυτό το μενού εμφανίζεται σε κατάσταση Object Mode. Στη κατάσταση επεξεργασίας θα αλλάξει το απαιτούμενο 
μενού με τα εργαλεία επεξεργασίας.  

Λίστα Καταστάσεων  

 

Η drop-down λίστα Mode. 

Το Blender έχει μια πληθώρα καταστάσεων για χρήση.  

 Το Object mode σας επιτρέπει να δουλεύετε με τα αντικείμενά σας ως σύνολο.  

 Το Edit mode σας επιτρέπει να επεξεργάζεστε το σχήμα των αντικειμένων.  

 Το Sculpt mode σας επιτρέπει να κάνετε τον κέρσορα εργαλείο για το λάξευμα 
ενός αντικειμένου.  

 

Λίστα Σκιάσεων  

Σας επιτρέπει να αλλάζετε τη θέαση των αντικειμένων 3D καθώς προβάλλονται στο παράθυρο προεπισκόπησης.  

 Bounding Box  

 Wireframe  

 Solid  

 

Επιλογέας Σημείου Περιστροφής  

Καθώς περιστρέφετε ή αλλάζετε κλίμακα σ’ ένα αντικείμενο ίσως επιθυμείτε 
να μετακινήσετε το σημείο περιστροφής στον τρισδιάστατο χώρο. 
Χρησιμοποιώντας αυτή την επιλογή μπορείτε να αλλάξετε το σημείο 
περιστροφής προς την κατεύθυνση του:  

 Active Element (Ενεργό στοιχείο)  

 Median Point - Μέσο σημείο  

 Individual Origins (Ατομική προέλευση)  

 3D Cursor (3D Κέρσορα)  

 Bounding Box Center  

Χρησιμοποιήστε το Object Center για να εναλλαγή μεταποίησης ολόκληρου 
του αντικειμένου ή μόνο τη θέση του.  

Επιλογέας Μεταποίησης  

Αυτοί οι εύχρηστοι επιλογείς, σας επιτρέπουν να περιστρέφετε ή να μετακινείτε αντικείμενα πιάνοντάς τα και 
κουνώντας τα στον άξονα.  
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Κλείδωμα στη Σκηνή  

Εξ αρχής, το κουμπί για το «κλείδωμα» στα δεξιά των επιπέδων είναι ενεργοποιημένο. Αυτό σημαίνει ότι σε αυτή 
την οπτική γωνία το ενεργό επίπεδο και η κάμερα είναι εκείνα όλης της σκηνής (και εκείνα που θα 
χρησιμοποιηθούν κατά την απόδοση). Όλες οι τρισδιάστατες όψεις είναι κλειδωμένες κατ’ αυτόν τον τρόπο έτσι 
ώστε να μοιράζονται το ίδιο ενεργό επίπεδο και την κάμερα. Όταν αλλάζετε τις ρυθμίσεις τότε αυτόματα 
αντανακλώνται και οι αλλαγές.  

Αν όμως απενεργοποιήσετε το κουμπί του «κλειδώματος», μπορείτε να ορίσετε διαφορετικά ενεργά 
επίπεδα/στρώσεις και κάμερα, συγκεκριμένα με την αυτή τη θέα. Αυτό μπορεί να είναι χρήσιμο λ.χ. εάν δεν θέλετε 
να έχετε τις περιοχές εργασία σας σωριασμένες με όλη τη σκηνή αλλά ακόμα να έχετε βοηθητικές οπτικές γωνίες. 
Ακόμα μπορείτε να έχετε διάφορες οπτικές γωνίες με πολλές ενεργές κάμερες . (Πιέστε το Ctrl+0 NumPad για να 
θέσετε το ενεργό αντικείμενο ως ενεργή κάμερα).  

Συγκράτηση στο πλέγμα  

Το κουμπί «μαγνήτης» ελέγχει τα εργαλεία συγκράτησης και σας βοηθά να μορφοποιήσετε και να μοντελοποιήσετε 
τα αντικείμενα.  

Κουμπιά Απόδοσης (Render)  

Τα κουμπιά απόδοσης αποδίδουν μια OpenGL έκδοση από την τρισδιάστατη εικόνα. Το πρώτο κουμπί αποδίδει μια 
ακίνητη εικόνα. Είναι σχεδόν ό, τι βλέπετε και στην επιφάνεια εργασίας, χωρίς το πλέγμα, τους άξονες κτλ. Απλά 
εμφανίζει τα αντικείμενα. Χρησιμοποιεί το ίδιο Draw τρόπο όπως η τρισδιάστατη θέα, οπότε είναι χρήσιμο εάν 
κάποιος σας ζητήσει να δει το πλαίσιο του αντικειμένου στο οποίο δουλεύετε. Το δεύτερο κουμπί θα αποδώσει ένα 
animation της τρισδιάστατης άποψης, κάνοντας χρήσιμη τη δημιουργία προεπισκόπησης. Το animation θα 
αποθηκευτεί σε επεξεργασμένες φωτογραφίες σε τύπο .avi ή μιας ακολουθίας εικόνων, ανάλογα με το ποιο έχετε 
επιλέξει. Μπορείτε επίσης να ορίσετε και τον αριθμό των καρέ στα Start και End πεδία.  
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Είδη προβολών/απόψεων 

 

Το Βlender σας επιτρέπει να δουλεύετε σε τρεις διαστάσεις, ενώ η οθόνη σας είναι δύο διαστάσεων. Για να 
δουλέψετε σε 3D πρέπει να μπορείτε να αλλάζετε τις οπτικές σας γωνίες καθώς και την κατεύθυνση στη σκηνή.  

 

Προοπτικές και ορθογραφικές απόψεις 

Mode: All modes  

Hotkey: 5 NumPad  

Menu: View » Perspective / View » Orthographic  

Κάθε μια γωνία 3D υποστηρίζει δύο διαφορετικούς τύπους προβολής. Αυτοί είναι η Ορθογραφική Προβολή 
(αριστερά) και η Προοπτική (δεξιά):  

 

Ορθογραφική (αριστερά) και προβολή προοπτικής (δεξιά). 

 

Τα μάτια μας είναι συνηθισμένα στην προβολή της προοπτικής επειδή τα απομακρυσμένα αντικείμενα φαίνονται 
μικρότερα. Η ορθογραφική προβολή συχνά φαίνεται παράξενη στην αρχή, επειδή τα αντικείμενα παραμένουν στο 
ίδιο μέγεθος ανεξάρτητα από την απόστασή τους. Είναι σαν να βλέπουμε τη σκηνή από ένα μακρινό σημείο στο 
άπειρο. Πάρα ταύτα, η ορθογραφική προβολή είναι πολύ χρήσιμη γιατί παρέχει μια πιο «τεχνική» ενόραση της 
σκηνής. Έτσι μπορούμε πιο εύκολα να σχηματίσουμε κάτι και να κρίνουμε τις αναλογίες.  
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Για να αλλάξετε την προβολή από μια 3D άποψη, επιλέξτε View >> Orthographic ή το View >> Perspective από το 
μενού. Το πλήκτρο 5 του NumPad εναλλάσσει αυτές τις δύο επιλογές.  

 

Δείγμα της άποψης της κάμερας. 

Η επιλογή View » Camera θέτει την 3D άποψη στην κατάσταση κάμερας. Η σκηνή προβάλλεται όπως θα αποδοθεί 
αργότερα. Η αποδοσμένη εικόνα θα περιέχει τα πάντα εντός του ορίου της κόκκινης διακεκομμένης γραμμής. Η 
μεγέθυνση ή η σμίκρυνση είναι δυνατή σε αυτή την άποψη, αλλά αν θέλετε να αλλάξετε τη γωνία θέασης πρέπει 
να μετακινήσετε ή να περιστρέψετε την κάμερα.  

 

Περιστρέφοντας την γωνία προβολής 

Mode: All modes  

Hotkey: Μεσαίο κλικ ποντικιού / 2 NumPad / 4 NumPad /            

6 NumPad / 8 NumPad / Ctrl+Alt+Wheel  

 

Menu: View → Navigation  

ο πρόγραμμα Blender παρέχει τέσσερις αρχικές 
κατευθύνσεις θέασης: Πλάγια (Side), Μπροστινής (Front), 
Κάτοψης (Top) και της Κάμερας (Camera). Το Blender 
χρησιμοποιεί τη δεξιά γωνία του καρτεσιανού επιπέδου με 
τον Z άξονα στραμμένο προς τα πάνω. Το «Πλάγια» 
αντιστοιχεί στην θέαση από τον Χ άξονα, στην αντίθετη 
μεριά ο «Μπροστά» αντιστοιχεί στον Υ άξονα και η 
«Κάτοψη» στον Ζ άξονα. Η θέα της κάμερας ακολουθεί την 
εκάστοτε θέση κάθε φορά.  
 

 

Μπορείτε να επιλέξετε να παρακολουθείτε διαφορετικές 
κατευθύνσεις μέσα από το μενού View ή πατώντας τα: 3 
Numpad για την «Πλάγια» 1 Νumpad για «Μπροστά» 7 
Numpad για «Κάτοψη»  

         A 3D viewport’s View menu. 
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Μετακίνηση και Ζουμ 

Για την μετακίνηση της γωνίας θέασης χρησιμοποιούμε την ροδέλα του ποντικιού πατώντας της προς τα μέσα, ενώ 
για μεγέθυνση ή σμίκρυνση την μετακινούμε πάνω ή κάτω. 0 Νumpad για την «Κάμερα»  

Ευθυγράμμιση της γωνίας θέασης 

Οι επιλογές αυτές σας επιτρέπουν να ευθυγραμμίσετε και να προσανατολίσετε την θέα με διάφορους τρόπους. Οι 
επιλογές αυτές μπορούν να βρεθούν στο μενού View.  

Align View to Selected  

Οι επιλογές αυτές ευθυγραμμίζουν τη θέα με συγκεκριμένους τρόπους θέασης  

Top    ⇧ Shift+7 NumPad  

Bottom   ⇧ Shift+Ctrl+7 NumPad  

Front    ⇧ Shift+1 NumPad  

Back    ⇧ Shift+Ctrl+1 NumPad  

Right    ⇧ Shift+3 NumPad  

Left    ⇧ Shift+Ctrl+3 NumPad  

 

Center Cursor and View All, (⇧ Shift+C)  

Μετακινεί τον κέρσορα πίσω στην αρχή και μεγεθύνει/σμικραίνει για να μπορείτε να δείτε τα πάντα μέσα στη 
σκηνή.  

 

Align Active Camera to View, Ctrl+Alt+0 NumPad  

Σας δίνει την ενεργή κάμερα στο τρέχον σημείο θέασης  

 

View selected, . NumPad  

Επικεντρώνει την θέα στα ενεργά αντικείμενα κεντράροντας σ’αυτά τη θέα και μεγεθύνει μέχρι να γεμίσουν τη 
σκηνή.  

 

Center view to cursor, Ctrl. NumPad  

Μαζεύει όλα τα αντικείμενα της σκηνής ώστε να είναι ορατά τα πάντα από τη γωνία θέασης.  

 

Τοπική και Ολική θέα 

Μπορείτε να εναλλάσσετε την Τοπική (Local) και την Ολική (Global) θέα επιλέγοντας την ομώνυμη επιλογή από το 
μενού View ή χρησιμοποιώντας το πλήκτρο / NumPad. Η τοπική θέα απομονώνει τα επιλεγμένα αντικείμενα έτσι 
ώστε να είναι τα μόνα ορατά από τη θέα. Αυτό χρησιμεύει όταν δουλεύετε με αντικείμενα τα οποία αποκρύπτονται 
από κάποια άλλα ή έχουν «δύσκολη» γεωμετρία. Πιέστε ξανά το / NumPad για να επιστρέψετε στην Ολική θέα.  
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Θέα Αποκοπής Περιθωρίου 

Mode: All modes  

Hotkey: Alt+B  

Menu: View » Set Clipping Border  

Για τη βοήθεια της διαδικασίας μορφοποίησης περίπλοκων αντικειμένων και σκηνών, μπορείτε να αλλάξετε τη 
γωνία θέασης απλά αποκόπτοντας το αντικείμενο για να το απομονώσετε στη θέα που επιθυμείτε. Το εργαλείο 
αυτό θα δείχνει μόνο το εσωτερικό το οποίο εσείς θέλετε. Με το που θα ενεργοποιήσετε το Alt+B θα πρέπει να 
ζωγραφίσετε ένα ορθογώνιο με το ποντίκι στην 3D θέα. Το αποτέλεσμα θα είναι ένα :  

 Δεξί παραλληλεπίπεδο αν είστε στην κατάσταση Orthographic  

 Πυραμίδα με τετράγωνη βάση αν είστε στην κατάσταση Perspective  

Παράδειγμα 

 

Region/Volume clipping. 
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Άποψη σκιάσεων 

Mode: All modes  

Hotkey: Z / ⇧ Shift+Z / Alt+Z / ⇧ Shift+Alt+Z / D  

Ανάλογα με την ταχύτητα του υπολογιστή σας, την πολυπλοκότητα της σκηνής και τον τύπο δουλειάς εκείνη τη 
στιγμή, μπορείτε να εναλλάσσετε διάφορες καταστάσεις σχεδίασης:  

 

 

Textured  

Εμφανίζει UV εικόνες μοντέλων με υφή χρησιμοποιώντας το OpenGL φωτισμό. Ούτε οι διαδικαστικές υφές ούτε η 
υφή με χαρτογράφηση θα εμφανιστούν.  

Shaded  

Προσεγγίζει όλες τις υφές και τους φωτισμούς κάθε κορυφής και συνδυάζει το ένα με το άλλο. Λιγότερο ακριβές 
από το να χρησιμοποιείται η μηχανή απόδοσης για τις υφές αλλά περισσότερο γρήγορο. Σημειώστε πως αν δεν 
έχετε φως στη σκηνή σας, όλα θα παραμείνουν μαύρα.  

Solid  

Οι επιφάνειες ζωγραφίζονται ως συμπαγή χρώματα, με ενσωματωμένο φωτισμό OpenGL. Αυτή είναι η 
προεπιλεγμένη κατάσταση σχεδίασης.  

Wireframe  

Τα αντικείμενα αποτελούνται μόνο από γραμμές που κάνουν το σχήμα τους αναγνωρίσιμο (π.χ οι ακμές των 
επιφανειών ή των σχημάτων)  

Bounding Box  

Τα αντικείμενα δεν σχεδιάζονται όλα. Αντίθετα η κατάσταση αυτή δείχνει μόνο τα τετράγωνα αντικείμενα που 
αντιστοιχούν σε κάθε μέγεθος και σχήμα του αντικειμένου.  

Μπορείτε να εναλλαχτείτε μεταξύ των καταστάσεων σχεδίασης :  

 Χρησιμοποιώντας την Draw type drop-down λίστα στις 3D απόψεις.  

 Πατώντας το πλήκτρο D για να εμφανίσετε το Draw mode μενού.  

 Χρησιμοποιώντας το πλήκτρο Z με τις συντομεύσεις του που αναφέρονται παρακάτω:  

Καταστάσεις Draw και συντομεύσεις με βάση το πλήκτρο Z.  

Z Εναλλάσσει τις καταστάσεις Wireframe και Solid  

⇧ Shift+Z Εναλλάσσει τις καταστάσεις Wireframe και Shaded  

Alt+Z Εναλλάσσει τις καταστάσεις Solid και Textured  

⇧ Shift+Alt+Z Γίνεται μεταφορά στην Textured κατάσταση.  
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Πίνακας Ρυθμίσεων της επιλογής View 

Mode: All modes  

Panel: View Properties  

Menu: View » View Properties...  

Πρόσθετα με τις επιλογές της κεφαλίδας που περιγράφτηκαν παραπάνω, o View Properties πίνακας σας επιτρέπει 
να θέσετε ρυθμίσεις άλλων αντικειμένων στην τρισδιάστατη άποψη. Το εμφανίζετε με το View » View Properties... 
μενού.  

 

Άποψη (View) 

 Lens :Ελέγχει το εστιακό μήκος της 3D άποψης της κάμερας σε χιλιοστά σε αντίθεση με μια κάμερα απόδοσης.  
 Lock to Object: Με την εισαγωγή του ονόματος ενός αντικειμένου στο πεδίο αντικειμένου, κλειδώνετε την 

άποψή σας για αυτό το αντικείμενο, δηλαδή θα είναι πάντα στο κέντρο της προβολής (η μόνη εξαίρεση είναι η 
ενεργή προβολή κάμερας, 0 Numpad). Εάν το κλειδωμένο αντικείμενο είναι οπλισμός, μπορείτε να κεντράρετε 
περαιτέρω την προβολή σε ένα από τα οστά της, εισάγοντας το όνομά της στον τομέα των οστών.  

 Lock to Cursor : Κλειδώνει το κέντρο της άποψης στην θέση του 3d κέρσορα.  
 Lock to Camera View : Στην Camera View χρησιμοποιήστε αυτή την επιλογή για να κινήσετε την κάμερα στον 3d 

χώρο, ενώ συνεχίζετε να είστε στην άποψη της κάμερας.  
 Clip Start και Clip End: Ρυθμίστε την ελάχιστη και τη μέγιστη απόσταση από την 3d κάμερα που θα είναι ορατή 

από το viewport.  
 Local Camera: H ενεργή κάμερα χρησιμοποιείται σε αυτή την άποψη.  
 3D Cursor Location : Εδώ μπορείτε να ρυθμίσετε ακριβώς τη θέση του 3D κέρσορα.  

 

Αντικείμενο 

Εμφανίζει το τρέχον επιλεγμένο αντικείμενο.  

 

Εμφάνιση 

 Only Render : Εμφανίζει μόνο το αντικείμενο που θα αποδοθεί.  
 Outline Selected : Αν απενεργοποιηθεί δεν θα έχετε πια το ροζ περίγραμμα γύρω από τα επιλεγμένα 

αντικείμενά σας στις επιλογές Solid, Shaded και Textured.  
 All Object Origins: Εάν είναι ενεργοποιημένο, το κεντρικό σημείο των αντικειμένων θα είναι πάντα ορατό, 

ακόμα και για τα μη-επιλεγμένα.  
 Relationship Lines : Ελέγχει αν οι διακεκομμένες γραμμές μπορούν να σχεδιαστούν ή όχι.  
 All Edges : Όταν η επικάλυψη πλέγματος είναι ενεργοποιημένη στο Αντικείμενο, αυτή η επιλογή πιέζει στο 

να εμφανίζονται όλα τα πλέγματα.  
 Grid Floor : Αν είναι απενεργοποιημένο, δεν έχετε άλλο πλέγμα παρά μόνο το ορθογραφικό 

πάνω/μπροστά/πλάγια.  
 X Axis, Y Axis, Z Axis : Ελέγχει ποιοι άξονες εμφανίζονται σε άλλες απόψεις αντί του ορθογραφικού 

πάνω/μπροστά/πλάγια.  
 Lines : Ελέγχει τον αριθμό των γραμμών που συνθέτουν το πλέγμα στη μη πάνω/μπροστά/πλάγια άποψη 

και στις δυο κατευθύνσεις.  
 Scale : Ελέγχει την κλίμακα του πλέγματος πεδίου.  
 Subdivisions : Ελέγχει τον αριθμό των υπογραμμών που εμφανίζονται σε κάθε κελί του πλέγματος όταν 

μεγεθύνετε καθώς και στις ορθογραφικές απόψεις.  
 Shading : Ελέγχει τον τρόπο με τον οποίο τα τρισδιάστατα αντικείμενα σκιάζονται.  
 Textured Solid : Εμφανίζει τις υφές σε στερεά άποψη.  
 Toggle Quad View : Ενεργοποιεί την 3d άποψη τεσσάρων πεδίων.  
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Εικόνες Φόντου 

Mode: All modes  

Panel: Background Image  

Menu: View » Properties...  

Το να έχετε μια εικόνα φόντου στην 3D άποψή σας είναι πολύ χρήσιμο σε πολλές περιπτώσεις: μοντελοποίηση, 
ζωγραφική, animation, κτλ.  

Μερικά χρήσιμα χαρακτηριστικά για τις εικόνες φόντου είναι:  

 Είναι συγκεκριμένες στο παράθυρό τους (πχ, μπορείτε να έχετε διαφορετικές εικόνες φόντου για κάθε μια 
από την 3D άποψη).  

 Είναι αποκλειστικά διαθέσιμες για τις ορθογραφικές απόψεις. Η εικόνα παραμένει η ίδια ενώ αλλάζετε 
μεταξύ των έξι απόψεων θέασης.  

 Το μέγεθός τους εξαρτάται από το μέγεθος του παραθύρου.  

 Μπορείτε να χρησιμοποιήσετε αρχεία βίντεο και κινούμενες σκηνές.  

Ρυθμίσεις 

 

Background Image panel. 

 

Το Βlender χρησιμοποιεί αυτά τα χαρακτηριστικά μέσω του Background Image μενού στο πάνελ των ρυθμίσεων. Εξ' 
αρχής αυτός ο τομέας έχει μόνο ένα κουμπί Add Image. Το κουτί επιλογών εναλλάσσει όλα τα χαρακτηριστικά. Αν 
ενεργοποιηθεί, μπορείτε να προσθέσετε μια εικόνα επιλέγοντας ένα υπάρχον μπλοκ δεδομένων, ή να φορτώσετε 
μια νέα εικόνα.  

Όταν η εικόνα φορτώσει, περισσότερες επιλογές γίνονται ενεργές:  

 Source : Καθορίζει τον τύπο αρχείου που θα χρησιμοποιηθεί. Ανάλογα με τον επιλεγμένο τύπο διάφορες 
επιλογές θα εμφανιστούν:  

 File: Χρησιμοποιήστε ένα αρχείο εικόνας.  
 Source File: Αναπαριστά το αρχικό αρχείο που συνδέεται με το τρέχον μπλοκ δεδομένου.  
 Sequence : Μια ακολουθία αριθμημένων αρχείων εικόνας  
 Frames : Θέτει τον αριθμό των εικόνων που θα χρησιμοποιηθούν σε μια ακολουθία.  
 Start: Θέτει τον αριθμό του καρέ που θα ξεκινήσει.  
 Offset : Αντισταθμίζει τον αριθμό των καρέ που χρησιμοποιούνται στην ακολουθία  
 Fields : Θέτει τον αριθμό των καρέ ανά αποδοσμένη εικόνα.  
 Auto Refresh: Ανανεώνει την εικόνα όταν αλλάξει το καρέ.  

http://wiki.blender.org/index.php/File:Background-image.png
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 Cyclic: Ανακυκλώνει τις εικόνες σε μια ακολουθία.  
 Movie: Χρησιμοποιεί ένα αρχείο ταινίας:  
 Match Movie Length: Ορίστε τον αριθμό των καρέ για να ταιριάζει με την ταινία  
 Generated: Χρησιμοποιήστε μια εικόνα παραγμένη από το Blender:  
 Width, Height : Θέτει το πλάτος και το ύψος της εικόνας σε pixels.  
 Blank: Παράγει μια κενή εικόνα.  
 UV Grid : Δημιουργεί ένα πλέγμα για να δοκιμάζει τις UV χαρτογραφήσεις.  
 Color Grid: Δημιουργεί ένα χρωματιστό πλέγμα για να δοκιμάζει τις UV χαρτογραφήσεις.  
 Opacity: Ελέγχει τη διαφάνεια της εικόνας του φόντου (από 0.0’ –αδιαφανές έως το 1.0 πλήρως διάφανο)  
 Size : Ελέγχει το μέγεθος, ή την κλίμακα της εικόνας στην προβολή 3D.  
 X Offset, Y Offset : Η οριζόντια και κάθετη μετατόπιση της εικόνας φόντου στην προβολή.  

 
Η άποψη της κάμερας είναι ένας τρόπος να κοιτάζουμε τη σκηνή. Οι κάμερες χρησιμοποιούνται για να συνθέσουμε 
εικονικά λήψεις και να δούμε πώς θα δείχνει η σκηνή μετά την απόδοση.  

Για να αλλάξετε την άποψη της κάμερας πιέστε το πλήκτρο 0 NumPad. Η σκηνή που είναι ορατή από την άποψη της 
κάμερας θα είναι αυτό που θα εμφανιστεί κατά την απόδοση. Οι κάμερες μπορούν να μετακινηθούν όπως 
οποιοδήποτε άλλο 3d αντικείμενο.  

Τοπική και καθολική προβολή 

Mode: All modes  

Hotkey: / NumPad  

Menu: View » Local View or View » Global View  

Όταν βρισκόμαστε στην τοπική άποψη μόνο τα επιλεγμένα αντικείμενα εμφανίζονται, πράγμα που μπορεί να κάνει 
την επεξεργασία περισσότερο εύκολη σε περίπλοκες σκηνές. Για να ενεργοποιήσετε την τοπική άποψη, αρχικά 
επιλέξτε το αντικείμενο που επιθυμείτε και έπειτα επιλέξτε από το μενού View ττην επιλογή Local View. Για την 
ολική άποψη χρησιμοποιήστε το View>>Global View. Το πλήκτρο / NumPad εναλλάσσει τις δύο απόψεις. 
Σημειώστε πως τα κουμπιά των επιπέδων και του κλειδώματος εξαφανίζονται όταν βρίσκεστε στην τοπική άποψη.  

Στην Ολική Άποψη, τα κουμπιά των επιπέδων είναι ορατά και ο πράσινος κύβος είναι επιλεγμένος. Η Τοπική Άποψη 
δείχνει ότι ο κύβος έχει κεντραριστεί και τα κουμπιά επιπέδων καθώς και η 3d άποψη έχουν εξαφανιστεί. Εαν η 
σκηνή έχει χιλιάδες ορατά αντικείμενα, αυτό το χαρακτηριστικό μπορεί να επισπεύσει την διαδραστικότητα μιας 
και ένα ή μερικά αντικείμενα θα είναι ορατά.  

                                                                                 Καθολική προβολή 

  

         Τοπική προβολή  

 

 

 

   

 

 

                  

 


